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Stappenplan computerpracticum Atlas.ti

Stap 1: Starten met een nieuw analyseproject

Start ATLAS.ti
* Start > Programs > ATLAS.ti > ATLAS.ti7

ATLAS.ti start op. Om ATLAS.ti te kunnen gebruiken moeten er eerst
(tekst)bestanden/transcripts geimporteerd worden.

Toevoegen documenten
Op dit moment is je HU (Hermenuetic Unit, i.e. de sessie) leeg, en moet je Primary
Documents (P-Docs) toewijzen, documenten toevoegen.
* Via het menu: Project > Add Document(s) > Add Documents (My Library),
zoek het bestand dat je wilt gebruiken in je map op en open het.
* In het kleine venster naast ‘P-Docs’ links in het scherm zie je ‘P1: naam
document’, klik hierop om de tekst te openen.
* Sla de HU op door: File > Save as. Geef het bestand een naam en sla het op in
de map waar ook de interviews in staan.

Je kunt eventueel de naam van het document wijzigen en een notitie aan je document
toevoegen door op het document te gaan staan = rechtermuisknop: ‘rename’ / ‘edit
comment’. Andere opties zijn o.a.: veranderen van de datum/auteur, toegankelijk via
‘Miscellaneous’ (tevens rechtermuisknop).

In de werkbalk boven de tekst zie je vier buttons voor je objectmanagers: P-Docs,
Quotes, Codes en Memos. Hier werk je veel mee. Deze ‘managers’ zijn tevens
toegankelijk via de menubalk, via respectievelijk de taps: Documents, Quotations,
Codes & Memos.

Kom je er niet uit? Bekijk eens onderstaande kennisclips:
- Maken van een nieuw project in Atlas.ti (Hermeneutic unit, HU).
https://youtu.be/p2RaRSaNZF8
- Toevoegen van documenten (Primary Documents, PD) aan een HU
https://youtu.be/9HkrOePZeM8

Stap 2: Coderen en eventueel importeren/(her)structureren bestaande codelijst

Coderen

Het aanmaken van losse codes kan via Codes > ‘create free code(s)’. Je kunt ook
meerdere ‘free codes’ achter elkaar aanmaken met behulp van pijltje naar beneden of
via Code Manager.

Coderen van tekst fragmenten

De volgende stap is het coderen van de quotes (tekstfragmenten). Athankelijk van
hoever je bent met het onderzoek geef je een naam aan een code. Hoe meer je nog in
de beginfase bent, hoe dichter je bij de tekst blijft. Ook selecteer je vaak een relatief
ruim fragment om voldoende context in de informatie mee te nemen. Vervolgens kun



je bijvoorbeeld meerdere codes toekennen aan 1 tekstfragment en kleinere
tekstfragmenten selecteren.

Selecteer een stuk tekst met je cursor, klik op de rechtermuisknop, selecteer ‘Coding’,
en probeer de verschillende manieren van coderen (Enter code name(s), Code in Vivo
(1 op 1 overname van geselecteerd tekstfragment/quote), Select Codes from List, Last
used Code(s)) uit. Dit coderen kan overigens ook via het menu, de Codes-Manager en
de verticale werkbalk links.

De code komt nu in de lijst te staan, zie de Code Manager. In het tabblad onder de
codelijst kun je een definitie/betekenis geven aan de code. Zo kun je (of een andere
onderzoeker) altijd terugvinden wat de (bedoelde) betekenis is van de code. Dit helpt
te voorkomen dat codes op verschillende manieren worden gebruikt.

Kom je er niet uit? Bekijk eens onderstaande kennisclips:
- Nieuwe codes maken https://youtu.be/cvvOsuSFhyl
- Coderen van tekstfragmenten https://youtu.be/NouyHaWGszA
- De code manager gebruiken https://youtu.be/jMnz7Tqoz28

Probeer nu structuur aan te brengen in je codelijst d.m.v. kleurtjes/nummering, etc..
Zie bijv.: http://atlasti.com/wp-content/uploads/2014/05/Woolf 2007-03_12.pdf

En het artikel van Friese 2011: http://www.qualitative-
research.net/index.php/fgs/article/view/1632/3149

* Overige opties codes (rechtermuisknop als je op een code staat in het
rechterscherm)

Het bewerken van codes

Mocht je na, of tijdens, het coderen erachter komen dat er toch een handigere manier

is of dat je een code wilt verwijderen dan kan dat. Er zijn verschillende opties: codes

hernoemen, deleten, unlinken of samenvoegen. Schrijf indien nodig memo’s.

o Het hernoemen en deleten van codes. Het belangrijkste dat je je moet realiseren
als je codes gaat deleten of hernoemen is dat dit op de hele HU wordt toegepast.
Als je een code hernoemt of delete (bijvoorbeeld adressen wordt woonplaatsen)
worden in het hele document alle codes veranderd (als je de code meerdere keren
hebt toegepast). In de marge zie je de links tussen de quotes en de codes, bij deze
bewerkingen worden dus alle links aangepast. Herbenoemen (‘rename’) en deleten
doe je door een code te selecteren in de marges en dan op je rechtermuisknop te
klikken. Probeer het ¢én en ander uit.

NB! Er is (nog) geen ‘undo’ knop waarmee je deleted codes terug kan krijgen.
Als je niet zeker weet hoe een bepaalde bewerking van je HU uit gaat pakken is
het verstandig om van te voren een back-up te maken.

o Het ‘unlinken’ van codes is in feite het tegengestelde van coderen; je verwijdert
de links tussen een quote en een code. In tegenstelling tot de delete-optie worden
niet de codes of de quotes verwijderd. De unlink optie zit op dezelfde plek als de
functies hierboven.

o Codes samenvoegen. Mocht je er op een gegeven moment (na het heroverwegen
van je data) achter komen dat je codes hebt gecreéerd die qua betekenis erg op
elkaar lijken (bijvoorbeeld ‘trouwen’ en ‘huwelijk’) kun je ze




samenvoegen/samensmelten (‘mergen’) in een ‘target’ code. Deze ‘target’ code
‘erft’ alle eigenschappen (links, memos, comment e.d.) van de oude code. Je kunt
codes samenvoegen in een ‘target’ code door: Open de Codes-Manager, selecteer
de ‘target’ code waar de andere codes in moeten opgaan, dan Codes >
Miscellaneous > Merge Codes, kies uit de lijst de codes die je wilt samenvoegen
met de ‘target’ code (alles kan ook simpele door codes in elkaar te slepen).

NB! Ook hiervoor geldt: het is niet eenvoudig om het ‘mergen’ van codes
ongedaan te maken. Sterker nog: dit moet handmatig. Maak vooraf dus een back-
up (geef het bestand een andere naam).

Extra: Het importeren van een bestaande lijst met codes in Atlas.

Een bestaande lijst met codes/codelijst (Word/Excel) kun je heel gemakkelijk via een
memo importeren in Atlas.

Ga naar de Memo Manager (via de tap ‘Memos’ of via de menubalk) en maak een
‘free memo’ aan via de knop ‘create a new item’ linksboven. De memo kun je
bijvoorbeeld topiclijst of codelijst noemen. Kopieer vervolgens je codes uit een Word
of Excel document naar het tekstveld in de aangemaakte memo.

Via de knop ‘Miscellaneous’ in de memo manager = ‘Create Codes from Selected
Memo’ kun je vervolgens in één keer je gehele codelijst importeren, zie ook:
https://youtu.be/cMkmN9 4P14

Stap 3: Het sorteren en (her)structureren van je data in Families

De volgende stap is het reduceren van de data en deze data in te delen in een logisch
systeem. Het groeperen van je data kun je het gemakkelijkste doen met behulp van
Families.

Families zijn groepen (clusters) codes (dit geldt ook voor memo’s en P-Docs’s) die je
gebruikt om je HU te systematiseren en te beheren. Vooral als je veel P-Docs’s, veel
memo’s of veel codes hebt is dat nodig en handig om ‘door de bomen het bos te
blijven zien’. Het is namelijk mogelijk om hele families te selecteren en te bewerken.
Dit gaat veel sneller dan wanneer je dat voor iedere code apart zou moeten doen. Het
is mogelijk om één code in meerdere families in te delen.

- Code Families maak je door: Codes > Families > Open Family Manager >
Families > New Family > geef de Family een naam. Herhaal dit voor je
overige families/thema’s. Nu heb je een lijst met hoofdcodes. Ga nu eerst
verder met coderen (zie stap 4). Als je alles hebt gecodeerd kun je je codes
vervolgens groeperen in je al opgestelde families. Als je dit punt hebt bereikt
dan kun je verder met de volgende stap, zie hieronder:

- Selecteer jouw Family in het scherm en selecteer een of meerdere codes uit het
kleine scherm rechtsonder en voeg de codes aan de Family toe met behulp van
<, sluit af. (Om codes uit je familie te verwijderen werkt het omgekeerd;
selecteer de codes in het kleine scherm linksonder en verwijder ze d.m.v. >)

- Codes kun je ook naar families ‘slepen’ naar het linker scherm via de ‘Code
Manager’

Kom je er niet uit? Bekijk eens onderstaande kennisclips:

- Codes groeperen in Families
https://www.youtube.com/watch?v=KDP8W3 gFpvMé&feature=youtu.be




Stap 4: Structureren van je geimporteerde documenten in families

Open Family Manager via: Documents = Families

Maak 1 of meerdere families aan via de button ‘Create a new family’ linksboven.
Sleep vervolgens de documenten naar de desbetreffende familie(s)

Sluit de Family Manager.

In de Primary Doc manager (button ‘P-Docs’, linksboven) zie je een overzicht van je
documenten en families. Je kunt je document van een toelichting voorzien door op het
document te gaan staan en vervolgens in het onderste tekstveld je notitie schrijven

Stap 5: Het belang van Memos en comments

Memos

Het is essentieel dat je tijdens kwalitatief onderzoek theoretische ideeén, reflecties,
twijfels en beslissingen documenteert. Dat doe je door middel van Memo’s aan te
maken. Het voordeel van memo’s is dat ze gekoppeld kunnen worden aan codes en
quotes (via ‘Link Memo to’ in de Memo Manager). Memo’s kunnen aan meer dan één
quote/code gebonden zijn. Ze kunnen ‘free’ zijn (niet gelinkt) of aan één of heel veel
quotes worden gelinkt.

Je kunt het type Memo (Commentary/Memo/Theory). aanpassen via ‘Type’ in de
memo zelf.

Lees hier meer over het effectief gebruik van memos om je onderzoek te
documenteren (middels je onderzoeksvragen): http://atlasti.com/wp-
content/uploads/2014/05/Friese_2009-09 1.pdf

Net als bij documenten en codes kun je je memo’s in families opdelen, bijvoorbeeld
een familie ‘onderzoeksvragen’, met subcategorieén voor je deelvragen. Je kunt deze
via de ‘Memo Family Manager’ opstellen.

Free memo

Een ‘free’ memo creéer je via Memos-Manager > Memos > Create Free Memo.
Voorzie je memo van een titel en selecteer het type memo. Vul wat tekst in. Sluit het
venster af (en bewaar het).

Link memo to quote/code

Selecteer eerst een quote door op de rechte balk in de marge te klikken. Selecteer het
Memo-icoontje in de verticale werkbalk links. Zie voor de rest hierboven. Zie het
symbool dat steeds in de marge verschijnt. Na het voorzien van de memo van tekst
kun je de memo opslaan met het V icoontje.

Een bestaande memo koppelen of één memo aan meerdere quotes koppelen

Je kunt één memo aan meerdere quotes hangen (bijvoorbeeld quotes die betrekking
hebben op een deelvraag) via de Memos- Manager. Selecteer een memo en ga naar
Memos > Link Memo to > Quote, selecteer de quotes.

Comments

Het is goed om belangrijke codes te omschrijven, zodat duidelijk is waarom je voor
de codenaam hebt gekozen. Vooral als je samenwerkt met anderen is het heel handig.
Comments maak je door op een code te gaan staan (in het rechter codeer paneel of via
de Code Manager), de rechtermuisknop aan te klikken en dan voor edit comments te
kiezen. Er verschijnt een schermpje waarin je jouw opmerking kunt schrijven. Sluit



het schermpje door de X in de rechterbovenhoek aan te klikken of via Comment,
Close.

Als je een comment op een code hebt gemaakt, dan komt er achter de code een tilde
(~) te staan. Deze tilde is aan de code gehecht. Je ziet deze telkens wanneer je de code
gebruikt.

Stap 6: Netwerken en relaties
Met deze functie kun je de structuren en patronen (van de pattern/axial coding)
visualiseren en evt. uitbreiden.

* Ga naar je Codes-Manager, selecteer alle of een aantal codes en klik het
netwerkicoontje aan onder de menubalk. Nu zijn relaties tussen de codes
gevisualiseerd.

*  Om meer links tussen codes te leggen, ga naar Link > Link Nodes, trek een
lijn tussen twee codes en selecteer een label om de relatie aan te duiden (is
associated with, is part of, is cause of, coutradicts, etc..).

* Je kunt deze codes bijvoorbeeld tevens linken met codes, code families,
memos, memo families, quotations en primary documents via: Nodes —>
Import Nodes = Node type vervolgens selecteren..

* Met de optie ‘Import Neighbors’ (rechtermuisknop bij een code) = ‘Import
Families” kun je de codes met hieraan gekoppelde families visualiseren.
Probeer meerder opties uit.

Zie ook de slides voor een uitgebreidere toelichting op de mogelijkheden om je
onderzoek (tussentijds) te visualiseren.

Kom je er niet uit? Bekijk eens onderstaande kennisclips:
- Networks of weak link relations
https://www.youtube.com/watch?v=14MWSFIDNGU&feature=youtu.be
- Networks of strong link relations
https://www.youtube.com/watch?v=dTPSvwYEQOTw

Stap 7: Analyseren van je data

ATLAS.ti bied je een aantal instrumenten waarmee je de data verder kunt gaan
analyseren.

Query Tool

Met behulp van de Query Tool (verrekijker-icoon in de hoofdmenubalk of via
‘Analysis’ in de menubalk) kun je quotes opvragen aan de hand van de codes of
families die je eraan hebt gehangen.

Tip: Combineer bijv. 2 termen uit je onderzoeksvragen voor je zoekopdracht!

* Ga naar Query tool (‘verrekijker’ icoon), selecteer bijvoorbeeld een ‘familie’
en een ‘code’ door hier dubbel op te klikken, deze verschijnen vervolgens in
het ‘query’ scherm rechts. Nu dien je nog een ‘operator’ te kiezen door hier
dubbel op te klikken.



* Je kunt een specifiecke zoekopdracht geven met behulp van zogeheten
‘operators’ waarbij de codes en families doorzocht worden die voldoen aan de
condities die je daaraan stelt (bijvoorbeeld AND{ en OR|}). De bovenste 4
Boolean functies (or, xor, and & not) zijn de meest gebruikte (zie ook de
onderstaande figuur). De functie van de operator wordt zichtbaar door er met
je muis op te gaan staan. In het scherm rechtsonder zie je vervolgens het
resultaat van je zoekopdracht ‘query’, het aantal quotes.

* Probeer een aantal combinaties van codes/families uit met desbetreffende
‘operator’.

* Met ‘C’ rechtsboven kun je je oude zoekopdracht verwijderen en vervolgens
een nieuwe zoekopdracht plaatsen.

* Met de functie ‘scope’ (rechtsonder) kun je bijv. je zoekopdracht verfijnen op
een bepaald criteria, zoals een specifiecke gemeente (p-doc) of familie, bijv.
een leeftijdscategorie. Let op!! Het resultaat is zichtbaar in het hoofdscherm!!

* Met het print-icoontje kun je vervolgens output genereren, dwz de ‘quotes’ die
je hebt gegenereerd met behulp van je zoekopdracht > Full Content > OK, om
je resultaten te zien.
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Figure 211: Boolean queries depicted as Venn diagrams

Operators

Three sets of operators are available. They are located within the toolbar at the left edge of the
Query Tool.

Boolean operators allow combinations of keywords according to set operations. They are the most
common operators used in information retrieval systems.

Semantic operators exploit the network structures that were built from the codes.

Proximity operators are used to analyze the spatial relations (e. g., distance, embeddedness,
overlapping, co-occurrence) between coded data segments.

Cooccur: finds quotations co-occurring with others. Essentially a combination of all other proximity
operators.

Kom je er niet uit? Bekijk eens onderstaande kennisclips:
- Query Tool https://youtu.be/s22Mbrx6Juw
- Co-occurrence https://youtu.be/QsOkb7zzpuA

Uitgebreide video gebruik data analyse tools (duur: 1 wur 10 min.):
https://youtu.be/4fv9qt2aTeA




Creéren van Super-Codes

Je zoekopdracht kun je bewaren middels de ‘Super Code’ functie (zie tab tussen de
twee zoekschermen). Je kunt je zoekopdracht verder verfijnen door gebruik te maken
van de ‘scope’ functie, rechtsonder in het scherm. Zie ook de verdere toelichting in
jullie analyseplan (Ad a. Analyses per case).

Met het ‘print’ icoontje kun je vervolgens de output genereren, d.w.z. een lijst met
quotes volgend uit je zoekopdracht.

Voor zowel het creéren van ‘super-codes’ als ‘super-families’ (toegankelijk via code-
family manager (rode vierkantje)) zijn alleen de Boolean operators beschikbaar.

Stap 8: Genereren van output

ATLAS.ti biedt vele mogelijkheden om output te genereren. Typische tekstuele
output zijn lijsten van codes, memo’s, families en quotes. Vanuit elke Manager (P-
Doc Manager, Family Manager, Quotation Manager, Code Manager, Memo Manager)
en de Query Tool kun je ‘Output’ genereren. (Zie ook de vorige stap, genereren van
een lijst met quote d.m.v. een zoekopdracht via de ‘Query Tool’)

Codes-Primary-Documents-Table
Een veelgebruikte output is de Codes-Primary-Documents-Table, een tabel die
frequenties rapporteert van quotes over meerdere P-Docs’s:

* Toegankelijk via: Analysis = Codes-Primary Documents Table

* Ga naar Codes-Manager > Output > Codes-Primary-Documents-Table >
Selecteer de codes in het linker boven scherm en >>> naar Selected
Codes/Families. Dit geldt ook voor de Primary Documents (scherm links
onder) die naar Selected PDs/Families toe moeten. Klik dan op Create Report
(het duurt even voor alles is verwerkt in een Excel file).

*  Qutput van alle quotations (inclusief comments en memos) wordt als volgt
gegenereerd: Ga naar Quotations-Manager > Output > All Quotations (include
quotations, comments, memos and hyperlinks content) > Editor.

* Probeer eens uit of je met dezelfde zoekopdracht in de Query tool hetzelfde
aantal quotes genereert, maar nu met de codes-primary-documents-Table.

Code-Primary Documents Table: https://youtu.be/O6AZexhtfaE

Stap 9: Het creéren van een transporteerbaar Atlas.ti document (copy bundle)
Als u in Atlas.ti samenwerkt met anderen die niet van dezelfde server als u gebruik
maken of als u thuis op uw eigen computer wilt werken, dan moet u een file creéren
die overal kan worden geopend en bewerkt. En die u weer op uw werkplek kunt
openen. Zo’n soort file heet een Atlas.ti copy bundle. Sla je bestand op (save),
vervolgens save as copy bundle. Als je weer met je project gaat werken dien je je
bestand (copy bundle) weer uit te pakken, te ‘unbundlen’. Dit gaat als volgt: je gaat
naar Project en klikt unpack copy bundle aan. In het scherm dat verschijnt staat de HU
in de bundle; selecteer de. klik ubundle aan en je kunt weer werken. Het is raadzaam
om aan het eind van elke werkdag niet alleen je HU op te slaan, maar er ook telkens
een copy bundle van te maken.

¢ Atlas.ti afsluiten met copy bundel! https://youtu.be/teMmKraa8jl




Algemeen

Korte video-introductie Atlas.ti (7.05 min.): https://youtu.be/8SW54ZWOqPVg
Atlas.ti handleidingen: http://atlasti.com/manuals-docs/

Quick tour (7.5): http://downloads.atlasti.com/quicktour/QuickTour_a7_en.pdf

User Manual (7): http://downloads.atlasti.com/docs/manual/atlasti v7_manual en.pdf

Help functie in Atlas.ti (toegankelijk via de werkbalk) = Atlas.ti Help

Voorbeeld Casus (uitgewerkt): Quick Tour: Load ‘Children and Happiness Stage II’

Overig
synchroniseren van documenten met audio files

Dit is mogelijk via de 'association editor":

1) Load the audio or video PD into the second region of the HU editor (see "Multi- Document View").
Multi-Document View

When you click on the plus sign on the right hand side of the HU editor, you can open up three more
regions for displaying documents. Thus, you can simultaneously view (and work on!) up to four
documents side-by-side.

Drag a document from the navigation pane (or the PDocs Manager onto the region button at the right
hand side of the HU Editor to load a second document. Alternatively, click on the region button first to
open a new region and then drag a document in the empty region pane.

2) Next you need to associated the two files with each other.
From the main menu select DOCUMENTS / ASSOCIATED DOCS / ASSOCIATE WITH PD FROM
REGION.

You can also associate documents by dragging & dropping them from the PDocs Manager into the
Association Editor. To open the Association Editor chose DOCUMENTS / ASSOCIATED DOCS /
OPEN ASSOCIATION EDITOR.



